Tamil Nadu Public Service Commission (TNPSC)
Online Registration

Objective :

Over 170 tests meant for Government servants as required under various service
rules, including those of TNEB, TWAD & Chennai Metro water, are conducted by
TNPSC every six months. This is also a fairly large piece of work as about 60,000
personnel take the exams every May and 25,000 every December.

This “ONLINE REGISTRATION” web application designed, developed and hosted by
NIC Tamil Nadu State Centre as per the specifications prescribed by the Tamil Nadu
Public Service Commission is the first of its kind in our country. TNPSC regularly
conducts various Recruitment Examinations for the selection of suitable candidates to
the posts in the Departments of Government of Tamil Nadu.

Designed & hosted by [
National Informatics
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Download and to the Candidates

Current Online Registration for...

(Click to Apply Online)

o o S Online upto
Group 1 Services Recruitment Examination 257 25 Jan 2011
Dec
o 5 o S Online upto
Combined Subord
Services E ion T 258 09 Feb 2011

ARCHIVES - YEAR 2010
[ honth

Jan Speech & Hearing Specialist AND Microbiologist
Feb Section Officer (Translation) Recruitment Examination

College Librarian Recruitment Examination

School Assistant Recruitment Examination

Sci. Asst. Grade II Recruitment Examination

Asst. Surgeon (Dental) Recruitment Examination
Asst. Geologist Recruitment Examination

Mar Curator and Asst. Curator Recruitment Examination

Departmental Examinations May 2010

Jun Assistant Director & Child Development Project Officer Recruitment Examination
Veterinary Assistant Surgeon Recruitment Examination
Jul Combined Engineering Services Examination

Village Administrative Officer Recruitment Examination B

Done & mternet 43 - H00% -

In the normal mode, the candidates obtain the Application Forms for these
recruitment examinations by sending the requisition letter to TNPSC along with the
Application Fee. Then, they send the filled-up Application Form along with the
necessary Examination Fee by post / courier.

To make this process simpler, TNPSC has decided to make use of IT tools so as to
enable the Candidates APPLY ONLINE. By this process, TNPSC receives not only the
hard copy of the signed application form along with Demand Draft/Postal Receipt for



Examination Fee and Photographs but also the electronic form of application form
with all essential details. This process considerably reduces the data entry and
verification time for the TNPSC.

As per the Input and Output Forms specifications, the first ONLINE REGISTRATION
web application was designed, developed and hosted for the Departmental
Examinations — May 2004 in the month of March, 2004. As the response for this
initiative was very much encouraging, TNPSC extended this ONLINE REGISTRATION
to different Recruitment Examinations, like “Asst. Medical Officers”, “Asst. Public
Prosecutor”, “Veterinary Asst. Surgeons”, “Group IV Services”, *“Village
Administrative Officers”, “Health Officers” etc. Normally the Online Registration will
be made available to the applicants for ONE Month period.

Features

This is a web-based project, which captures the essential details of the Candidate
applying to that particular Examination through an user-friendly form, assigns an
Application No. and generates both the pages of Application forms in A4 size papers,
with sufficient space for photograph, signature and postal receipt. Candidate can
take the print out of these Application Forms. The Candidates have to send this duly
signed Online Application Form and other document copies along with the Demand
Draft or Postal Receipt towards the Application and Examination Fee and
photographs, to TNPSC by post.

Hard copy of the filled-up Application forms can be generated any point of time by
furnishing the Online Register No. and the Date of Birth of the candidate.

This web application has one “HELP” Corner with the documents like Instructions to
the Candidates, Notifications in English and Tamil, Time table, Syllabus. The
“FEEDBACK” corner enables the Applicants to send e-mails to the Controller of
Examination to get clarified their doubts regarding the examinations.

Implementation Status :

Till 31 December 2010, 112 ONLINE REGISTRATION projects have been
successfully designed, developed and hosted by NIC-TNSC.
(URL : http://tnpsconline.tn.nic.in )




Home Page :
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Tamil Nadu Public Service Commission ot viewed vith 800XE00 " .
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Online Registration and vith Medium Text size

Disclaimer

Instructions Instructions

Online A, tion Form
Candidates can either submit their applications online till 5.45 P.M. on 25/01/2011 or through Apply Online
applications obtained from the Commission’s Office /Head Post Offices.

Print Online Application Form
Help

List of Examination Centres
List of Posts

Fees: Rs.105/- (Rs. 75 - Ezamination Fee + Rs. 30 - Application Fee). The fee should be paid only
through Postal Receipt obtained from any one of the Post Offices or Sub-Post Offices. Candidates
applying Online should possess and keep ready the Postal Receipt for this amount before start

entering the details. List of Post Offices
Syllabus
Procedure to apply online: List of Sub-Castes (FDF)

Notification (PDF)
Instructions (PDF)
Information Brochure (PDF)

a. Read carefully the Instructions / Brochure / Notification-Advertisement before Filling up the
Application form.

Click "Apply Online” tab appeared in vour right hand side. V\Tmﬁ

Fill-up/Select the relevant particulars asked in the data entry screen carefully. =
. . Send your suggestions

After confirmation, click "Yes, Generate Online Application Form" button.

An unique application number will be generated. Kindly note it.

Type the application Number and vour date of Birth to generate online application form.

Print the generated application forms (2 pages), affix your signature, paste one recent
passport size photograph, affix the Postal Receipt towards the Examination Fee and
Application Fee in the 2nd page and send it to the Commission's Office on or before the last

date.

Note: Mere data eniry of application alone is not an online registration. Online application

he sy ilv_reiected
o @ mtermet | 3 - Rw0w -
B Information Brochure U‘DH EJ
b, Click "Apply Online” tab appeated in your right hand side. TV pdol

P

c. Fill-up/Select the relevant particulars asked in the data entry screen carefully. .
: . Send your suggestions

d After confirmation, click "Yes, Generate Online Application Form" button.
e, An unique application number will be generated. Kindly note it.
f. Tvpe the application Number and your date of Birth to generate online application form.

g. Punt the generated application forms (2 pages), affix your signature, paste one recent
passport size photograph, affix the Postal Receipt towards the Examination Fee and
Application Fee in the 2nd page and send it to the Commuission's Office on or before the last
date.

Note: Mere data entry of application alone is not an online registration. Online application
forms without Signature and photograph will be summarily rejected

4. Last date: The candidates can register their particulars online and generate printout till 5.45 P.M. on
25/01/2011. They will have to generate the printout of the filled-up application form by clicking
"YES, Generate Online Application Form' burton, paste one recent passport size photograph, affix
the Postal Receipt towards the Examination Fee and Application Fee, affix the signature and send it
to the Commission’s Office on or before 28/01/2011 - 5.45 P.M.

5. Before taking the printout of the Application Form, make sure that both Top and Bottom margins of
the print area will have only 3 mm (This can be adjusted using File->Page Setup option of the
browser.).

6. The candidates who apply online will Superscribe “Online Application - Group I Services
Recruitment Examination” on the envelope before despatching to the following address :

The Controller of Examinations

Tamil Nadu Public Service Commission
Commercial Taxzes Annexze Building
Greams Road

Chennai - 600 006

“SUINPSC L rdegorind L G enl,

@ mtermet | ¥ - Bwoow -




Exami

List of Examination Centres

nation Centres :

Web Appiication designed and hosted by
National Informatics Centre, Chennai

Best viewed with 200XE00 monitor resclution
and with Medium Text size

Disclzimer

Centre Name Centre Apply Online
i Print Online Application Form
ARTYALUR 30

CHENNAT

CHIDAMBARAM

104

COIMBATORE 2 List of Post Offices
DHARMAPURI 4 Syllabus
DINDIGUL 5 List of Sub-Castes (PDF)
ERODE 5 Notification (PDF)
KANCHEEPURAM 7 Instructions (FDF)

Information Brochure (PDF)
KARAIKUDIT 138

FuY oo pdo

KARUR 4 Adube
KRISHNAGIRI 31 Feedback
MADURAL 10 Send your suggestions

HAGAPATTINAM

11

MAGERCOIL

HAMAKKAL

12

PERAMBALUR

14

PUDUKOTTATL

b5

RAMANATHAPURAM

16

SALEM

17

SIVAGANGAT

18

THANJAVUR

19

THE NILGIRIS

13

LT

List of Examination Centres
List of Posts

Posts :

‘mpsconline. m.nic.in/GO0S Posts. asp
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Web Applicstion designed snd hosted by
National Infermatics Centre. Chennai

Best viewad with B00X600 monitor resolution
and with Medium Text size

Disclaimer

List of Posts

Onfine Application Form.

Post Name

Apply Online
Frint Online Application Form

Assi Commissioner (C.T.0)

Asst.Director of Rural Development Department

Deputy Collector

Deputy Sperintendent of Police (Cat-I)

District Registrar

Divisional Officer in Fire and Rescue Services

Total No. of Posts : 7

List of Examination Centres
List of Posts

List of Post Offices
Syllabus

List of Sub-Castes (PDF)
Hotification (PDF)
Instructions (PDF)
Information Brochure (PDF)



Post Offices :
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List of Post Offices (to get Postal Receipts)

Code Post Office Name and address

094 .AREYALUR,Peramba[ur Road-621 713

194 .ARIYALUR - SENDURALKamara] Street-621 714

294 .ARNALUR—UDAYARFALAYAM,POSR Office Street-621 804

oo1 CHENNAI - AMBATTUR,TI Cycles Road-600 053

ooz CHENNAT - ANNA ROAD,824, Anna Road-600 002
CHENNAI - AVADI CAMP,HVF Road-600 054
.CHENNAI* EGMORE NDSO,5/6, Kenneth Lane-600 008
.CHENNJ'-\.P G.P.0.,1/10, Rajaji Salai-600 001
.CHENNAI— MYLAPORE, Cutcherry Road-600 004
.CHENNAI— PERAMBUR,39, Selvavinayagar Koil Street-600 011
CHENNAI - TONDIARPET, 244, Madras Dock Labour Board Housing Colony-600 081
CHENNAI - FORT ST. GEORGE,33/4, Fort St. George-600 009
CHENNAI - PARK TOWRWN,37, Evening Bazzar Road-600 003
.CHENMAIf POONAMALLEE, 111, Ra}.a Agraharam Street-600 056
.CHENN.AI— ST. THOMAS MC‘UNT,I-U, GS:I' Road-600 016
.CHENNAI— T. HAGAR,Sivagnanam Road-600 017
CHENNAI - T.NAGAR NORTH,Flot No.107, North Usman Road-600 017
CHENMAI - TAMBARAM,Muthuranga Mudali Street-600 045
CHENNAI - TIRUVOTTIYUR,Near Teradi Bus Stop Tiruvottiyur High Rd.-600 019
.CDIMBATDRE,GM& Shé(‘f Road-641 001
|COIMBATORE CENTRAL, 745, Avanashi Road-641 018
:CD}MBATORE MEETUPALA‘(‘AM,KaramadEi Roadf-641 201

Done & Internet 4y - Himwow v

Syllabus :
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Related Links Recruitment Recruitments & Results Schedule of Exam +/ REGISTER ONLINE

Syllabus .

HOME « General Knowledge

g e « General Tamil
« General English

R SR TR « Post Graduate Degree Standard
« Degree Standard

« Diploma Standard

ANNUAL REPORTS » Certificate Course

« Intermediate Standard

DEPARTMENTAL TESTS

ANNOUNCEMENTS
« HSC Standard
‘ORAL TEST (Interview) « SSLC Standard
« Law
SUGGESTIONS

« Civil Judge

SYLLABUS H Assistant Public Prosecutor Grade II
« Medical Speciality Subjects

= Miscellaneous

€ Internet 45 v Wimw v



Data capturing form :

= - . = Web Applicstion designed and hosted by

’lﬂmﬁl‘!@ Siya usmiwmemi Ggieumsnsmmuln Nationzl Informatics Centre, Chennai
Tamil Nadu Public Service Commission Best vi 4 with B00%500 " .
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Disclzimer

Group I Services Recruitment Examination

Data Entry Screen to Generate Online Application Form Instructions
(Note: Application Fee Rs. 30 is compulsory for all candidates irrespective of the Communal Category. Online Application Form
Please keep ready the Postal Receipt and start entering the data.)

Post applied for ! Group I Services

Examination Centre ? | colact 3 Centre Print Online Application Form
Subject chesen ? | General Knowledge (1) L

List of Examination Centres

Apply Online

Candidate's Name ? List of Posts

(vith Initials =t the =nd) ;
Father's / Husband's Name ? List of Post Offices
(vith Initials at the =nd) Syllabus

Address for communication ?

List of Sub-Castes (PDF)
Notification (PDF)
Instructions (PDF)

Information Brochure (PDF)

PIN Code ?

!

Adobe”
District 2 | Ariyalur [:Iﬁermbc

Date of Birth 2
(Date;Mt:th.f\l’ear) l:l (Eg.: 04/05/1060 for 4th May 1060) Feedback
Gender® @ male O Famale Send your suggestions

Religion 2 | jindu

Community and | others

<]

Sub-caste Serial No. ?

|

(Help)
Nationality 2 @) ;ndian O Others
Candidate's Nativity ? | Tamil Nadu

!

Father's Place of Birth ?

<]

Ariyalur
Destitute Widow 2 OYES @ Mo
Ex-Service Man ? OYes @ Mo

Differently Abled - Type 2
(Eligibility - mors than 40% Dissbility)
‘Whether "Scribe" is required ? OYES @ Mo

Details :

& Internet -
Examination passed in Tamil ? | pegree

Technical Qualification 3
) Typowriting - Tami 3 O sr.Grade O ar.Grade @ Hone
Enghshz O 5rGrade O IrGrade @ nene

b)ShortHand -Tamil? () o g O iroGrade @ Hone

English? O sr.Grade O ar.Grade @ none
Do you passess prescribed practical experience 2 () .. @ yo

Highest ional / Techni None

Qualification 2

Employment Status ? | yone

If employed, Post held
and Department/Organisation ?
Previously appeared for Written / Oral Test 2~ . __ @

Departmental Disciplinary action taken 2 () . __ @)

1f "Yes', details 7 & Initiated O Pending ) Punishment Awsrdad
C nal Case ?| O ves @ no

If 'Yes', details 7 () Registerad () Pending ) Punishment Avarded

Participation in Political Activities ? 1. in saitation : Oves @ No.
2. as a member of political organisation : () Yes & o
3. candidature in elections O ves @ no

Fees (Postal Receipt) Details :
Do you claim Fee Exemption 2 @) (),

1f "Yes', No. of Free Chances availed alrezdy 7 |0
Under which category Fee exemption is claimed? | gne

Do you claim Age Concession ? @ Yes O No

If "Yes', Category 7 | None

Postal Receipt No. 2
(First 10 Characters) (If more than Postal Receipt is obtained, please enter
first 10 characters of any one of the Postal Recaipts.)

Postal R ipt Date ?
(Datef,\c.‘?nw:e;) 06/01/2011 (Eg.:15/03/2004 for 15th March 2004)
Post Office ? | .

Postal Receipt Amount? @y o 105 (D Rs. 30 (with Concession)

Note :

Applicant CANNOT modify the entered details after pressing the button "Yes, Generate

online Application Form". So, before pressing this button please make sure that ALL ENTRIES
are correctly entered. Those who want to make correction in any of the columns after
pressing this button may have to submit a fresh Online Application Form.

Verified the entries ? Yes. Generate Online Application Form ] [ Mo, Reset all entries I

& nternet 3 -

B



Online Application Form generation :

Web Application designed and hosted by
Nationzl Infarmatics Centre, Chennai

Best viewed with 800X500 monitor resolution
and with Medium Text size

Disclzimer

Print Online Application Form

This option for taking the print out of the "Filled up Application Form" is to be used ONLY after
completing the "ONLINE REGISTRATION" successfully. Application Ne. refers to the "Online
Application No." generated by the software which will be informed to the Applicant at the end of
the successful online registration process.

Before takung the prntout of the 1st and 2nd pages of the Application Form, kindly make sure that
both Top and Bottom margins of the print area will have only 3 mm. (This can be adjusted using
File->Page Setup option of the browser)). Also, kindly set the 'Text sigf to "Mediusd' (This can be
adjusted using View->Text Size option of the browser) so as to take the printout of each page in
single sheets.

The candidates will have to take a printout of both the pages of the Application Form, affix their
signature, paste recent passport size photograph and paste the Postal Receipt (towards the

Examination Fee and Agplication Fee) in the space provided in the 2nd page and send it to the
Commission’s Office on or before 28/01/2011 - 5.45 P.M.

Online Application Number ?
Candidates’ Date of Birth (Date/Month/Year)  |23/11/1979 (Eg.: 04/05/1967 for 4th May 1967)

| Generate Online Application Form - Pages 1and 2 |

Apply Online

Print Online Application Form
e
List of Examination Centres
List of Posts

List of Post Offices
Syllabus

List of Sub-Castes (PDF)
Notification (PDF)
Instructions {FDF)
Information Brochure (PDF)

Al

| @ mtermet



Online Application Form — Page 1 :

.

Application No. : 100555 Examination Centre: CHENNAL

Candidate:

Post applied for :
Subject chosen :

Father's / Husband's Name:
Address:

Date of Birth:

Gender:

Differently Abled - Type:

Whether "Scribe” is required 7

Destitute Widow ?

Ex-Service man ?

Religion, Community and Sub-Caste Serial No. :
Hationality and Candidate's Nativity:

Father's Place of Birth:

Educational Quslificstion as on 28/12/2010:
Required Main Subjects Studied and Level of Qualification:

Month and Year of Publication of Results:
Examination Passad in Tamil:
Technical Quslification :
a) Typewriting - Tam
b) Shorthand - Tam

Do you possess prescribed practical experisnce 7

Highest Professional / Technical Educational Qualification:
Claimed Fee Exemption?

Claimed Age Concession?

Employment Status:

Post held and Department:

Previously appearad for Written / Oral Test ?
Departmental Disciplinary action details:

Criminal Case:

Participation in Political Activities:

Post Office :
Postal Rec

pt Date, Number & Amount :
Copies of Documents enclosed:  (Put 2 Tick mark in the relevant boxes)
1. Postal Receipt (to be pasted in the 2. Date of Birth
Generated Online Application)

' TNPSC- Group I Services Recruitment Examination-Online Application Form-Page 1 of 2

VALARMATHI A
Group I Services

1 - General Knowledge

ALAGAPPAN M

A VALAR MATHI, D/O M ALAGAPPAN, 26 MG PURAM
PERAMBALUR - 621212, Perambalur District

23 November 1979

Female

None

No

No

No

Hindu, Backward Class, 129

Indian, Tamil Nadu

Perambalur

Degree

1. Computer Science 024, Degree
2. None, None

NOV 2008
HSC

Typewriting - English: None
Shorthand - English: None

No
Degree
No  No. of fres chances: 0 Category: None

Yes Category:Backward Class / Backward Class
None

No
No
No

1. in agitation : No
2. as a member of Political Organisation : No
3. candidature in elections : No

CHENNAI-T.NAGAR
05 January 2011, 00000068, Rs.105

3. Community Certificste (Life Card)

Done & Internet £ -

Gender: Female
Differently Abled - Type: None
Whether "Scribe" is required ? No
Destitute Widow ? No
Ex-Service man ? No
Religion, Community and Sub-Casta Serial Neo. Hindu, Backward Class, 120
Hationality and Candidate's Nativity: Indian, Tamil Nadu
Father's Place of Birth: Perambalur
Educational Qualification as on 28/12/2010: Degree
Required Main Subjects Studied and Level of Qualification: 1. Computer Science 034, Degree

2. None, None
Month and Year of Publication of Results: NOV 2008
Examination Passed in Tamil: HSC
Technical Qualification ¢

a) Typewriting - Tamil: None Typewriting - English: None
b) Shorthand - Tamil: None Shorthand - English: None

Do you possess prescribad practical experience ? No
Highest Professional / Technical Educational Qualification: Degree
Claimed Fee Exemption? No  MNo. of free chances: 0 Category: None
Claimed Age Concession? Yes CategoryiBackward Class [ Backward Class (M)
Employment Status: None
Post held and Department:
Praviously appearad for Written / Orzl Test 7 No
Departmental Disciplinary action details: No
Criminal Case: No
Participation in Political Activities: 1. in agitation : No

2. as a member of Political Organisa

2. candidature in elections : No
Post Office : CHENNAI-T.NAGAR
Postal Receipt Date, Number & Amount : 05 January 2011, 00000068, Rs.105
Copies of Documents enclosed: (Put = Tick mark in the ralevant boxes)
1. Postal Receipt (to be pasted in the 2. Date of Birth 2. Community Certificate (Life Card)
Genarated Online Application)
4, Educational Qualification 5.Technical Qualification 6.Educational Qualification for Adequate

knovdedge in Tamil
7. Medical/Veterinary Registration 8. Practical Experience Certificates 9.Conduct Certificate from Group A or B Officer
Certificate/Bar Council Registration
Certificate/Driving Licence
10.Conduct certificate issued by the last 11. Fitness Certificate 12.Differently abled Certificate
studied Institution
13. Destitute Widow Certificate 14, Ex-serviceman Certificate 15.Declaration in separate sheet
16.Extra-curricular activities 17. Details regarding Disciplinary Action/Criminal 18.0ther Special Records if any specified in the
Action/Pravious Appezrance/Political participation, Advt./Notification
if any
Print Page 2 of 2
Done & Internet 100% -




Online Application Form — Page 2 :

TINPSC- Group I Services Recruitment Examination-Online Application Form - Page 2 of 2

(Fill up the columns - Plsce of Birth, State & Mother Tongue and send zlong with application)

2) Name and Address of the Applicant

Thiru/Tmt./Selvi: VALARMATHI A

A VALAR MATHI, D/O M ALAGAPPAN
26 MG PURAM

PERAMBALUR-621212

Perambalur District

b) Place of Birth:

<) Mativity: Tamil Nadu
State:
d) Mationality: Indian

=) Mothar Tongus:

g] Father's / Husband's Name:
Undertakings:

ALAGAPPAN M

Application Number

100555

Affis signed recent passport size photograph

1. T hereby declsre that all the particulars furnished in this application are true, correct and complete to the best of my knowledge and belief. In the event of
any information being found false or incorrect or ineligibility being detected befare or after the examination, action can be taken against me by the TNPSC.
2. I further declare that 1 fulfill all the eligibility conditions prescribed for admission to the examination.
3. I have informed my employer in writing that I am applying for this Examination.

4. I have gone through the Instructions, Brochure and the Commission's Notification/Advertisement for this Recruitment before filing up the application form. I
also certify that 1 have not been debarred by the THBSC or any other recruiting agency. I alsa certify that no Criminal (except the particulars furnished in Dept.

Disciplinary Action/Criminal case columns) nor any disciplinary procesdings have been initisted or pending against me.

5.1 daclare that 1 possess the physical standards prescribed for this post for which now I am applying.
6. I declare that 1 will not be a party te any kind of canvassing on my behalf.
7. 1 dedlare that I have not suppressed any material information as indicated in para 20(c) of the Instructions.Etc to Candidates.

2.1am not a dismissed Government Employes.

Application Submitted on: 06 January 2011

Postal Receipt towards
Examination fees/Application fees
to be pasted here

SIGNATURE

Done

Online submission status — Centre-wise list :

| @ mternet 43 - ®00%

Done
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Tamil Nadu Public Service Commission
Online Registration

Group I Services Recruitment Examination

Web Appiication designed and hosted by
National Informatics Centre, Chennai

Best viewed with 800X500 monitor resolution
and with Medium Text size

Disclzimer

Online Application submission Status as on 06/01,/2011 12:21:08 Instructions
Online Application Form
View Latest 50 Application details Apply Online
Centre Applications submitted Print Online Application Form
Select a Centre 1 Help
ARIYALUR 6 List of Examination Centres
CHENNAT 157 List of Posts
CHIDAMBARAM 10 List of Post Offices
COIMBATORE 35 Syllabus
DHARMAPURI 26 List of Sub-Castes (PDF)
DINDIGUL 16 Notification (PDF)
ERODE 33 Instructions (PDF)
KANCHEEPURAM 8 Information Brochure (PDF-)
KARUR 8 Lﬂ-mﬁk
KRISHNAGIRI 7
MADURAL 7 Send your suggestions
NAGAPATTINAM 2
NAGERCOIL 22
NAMAKKAL 11
PERAMBALUR. 3
PUDUKOTTAI 4
RAMANATHAPURAM 10
SALEM 24
SIVAGANGAL 5
THAMIAVUR 10
THE NILGIRIS 7
THENI 3
THIRUVALLUR 13

| @ Internet 5 v ® 100%



Online submission status — Applications submitted for a Centre :

[

Wb Applicstion designed and hosted by
Nationzl Informatics Centre, Chennai

SIODETE Sirer L B
Tamil Nadu Public Service Commission Best vi d with 800%600 it luti
5 - 2 est viewed wi monitor rasolution
Online Registration and with Medium Text size

Disclaimer

Group I Services Recruitment Examination

Online Application submission Status as on 06/01/2011 12:21:27 Instructions
Online Application Form

Centre Submitted on Application No. Candidate IP No. Apply Online

DHARMAPURI 30/12/2010 22:59:00 100035 guru 1.38.61.1 Print Online Application Form

DHARMAPURI 31/12/2010 12:36:00 100058 ARULRAJAN P 117.207.98.148 Help

DHARMAPURI 31/12/2010 12:49:00 100060 ARULRAIAN P 117.207.98.148 List of Examination Centres

DHARMAPURI 31/12/2010 12:58:00 100062 BASKARARAI P 117.207.98.148 List of Posts

DHARMAPURI 31/12/2010 13:06:00 100065 P LATHA 117.201.18.28 List of Post Offices

DHARMAPURI 31/12/2010 13:53:00 100073 SENTAMILARASLU. 5 117.201.25.147 Syllabus

DHARMAFPURI 31/12/2010 14:23:00 100080 SENTAMILARASU. 5 117.201.25.147 List of Sub-Castes (PDF)

DHARMAPURIL 31/12/2010 16:09:00 100088 Bharath.D 210.212.62.55 Natification (PDF)

DHARMAPURI 03/01/2011 11:14:00 100186 METYAZHAGAN K 117.254.133.121 Instructions (PDF)

DHARMAPURI 03/01/2011 12:42:00 100198 MUKTHAR AHMED.K 59.99.140.230 Information Brochure (PDF)

DHARMAPURI 03/01/2011 16:54:00 100241 MARTYAPPAN.K 115.118.71.34 rﬁ‘.@rAdch'

DHARMAPURI 03/01/2011 17:16:00 100244 HARI RAGAVENDRAN M 110.225.187.209 ashe  Rea

DHARMAPURI 03/01/2011 19:24:00 100259 Bharath.D 210.212.62.55 Feedback

DHARMAPURI 03/01/2011 19:38:00 100265 Mithya J 59.96.8.68 Send your suggestions

DHARMAPURI 04/01/2011 12:40:00 100307 AKILANDESWARI T 220.227.30.146

DHARMAPURI 04/01/2011 13:11:00 100310 SARAVANAN T 118.95.125.175

DHARMAPURI 04/01/2011 14:47:00 100329 METYAZHAGAN K 117.254.131.171

DHARMAPURI 04/01/2011 17:04:00 100358 Bharath.D 210.212.62.35

DHARMAPURI 04/01/2011 21:09:00 100380 METYAZHAGAN K 117.254.125.115

DHARMAPURI 05/01/2011 10:45:00 100401 HARI RAGAVENDRAN M 117.193.153.200

DHARMAPURI 05/01/2011 11:17:00 100409 HARI RAGAVENDRAN M 117.193.153.200

DHARMAPURI 05/01/2011 12:03:00 100419 ELANGO P 122.174.135.46

DHARMAPURI 05/01/2011 12:22:00 100421 ELANGO P 122.174.135.46

DHARMAPURI 05/01/2011 14:42:00 100464 vinothkumar.s 117.206.114.123

DHARMAPURI 05/01/2011 18:25:00 100510 ARULRAIAN P 122.168.25.42 =
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Online Application submission Status - Latest 50 Applications as on 06/01/2011 12:21:48 Instructions
Online Application Form

Centre Submitted on Application No. Candidate IP No. Apply Online

TIRUFPUR 06/01/2011 12:19:00 100591 Sowmiya M 122.178.163.15 Frint Online Application Form

CHENNAT 06/01/2011 12:16:00 100590 Geetha 122.174.128.135 Help

CHENNAI 06/01/2011 12:15:00 100589 Badrinarayanan V 203.175.185.43 List of Examination Centres

PUDUKOTTAI 06/01/2011 12:13:00 100588 P MANJULA 59.99.192.59 List of Posts

VELLORE 06/01/2011 12:05:00 100587 SANTHOSHKUMAR.S 117.241.209.41 List of Fost Offices

MAGERCOIL 06/01/2011 12:04:00 100586 MASILA JOHN 1 122.164.55.164 Syllabus

CHENNAI 06/01/2011 12:04:00 100585 VDAYAKUMAR B 122.164.168.206 List of Sub-Castes (PDF)

THIRUVALLUR 06/01/2011 11:54:00 100584 Kalyani K 117.193.234.160 Notification (PDF)

COIMBATORE 06/01/2011 11:50:00 100583 dinesh khanna m 220.227.191.250 Instructions (PDF)

NAGERCOIL 06/01/2011 11:45:00 100582 THANA BALAN S 122.164.55.164 Information Brochure (PDF)

COIMBATORE 06/01/2011 11:30:00 100581 Senthil Kumar. S 117.197.189.173 r~‘-ﬁrﬁdﬂbc'

COIMBATORE 06/01/2011 11:25:00 100580 KARMAN N 122.178.177.194 adobe  Reea

CHENMAT 06/01/2011 11:25:00 100579 Rengasamy A 59.92.65.33 Feedback

KANCHEEPURAM 06/01/2011 11:18:00 100578 DURALP 117.204.29.76 Send your suggestions

KARUR 06/01/2011 11:16:00 100577 MNAVIEN.P.5.5 50.99.136.118

RAMANATHAPURAM | 06/01/2011 11:15:00 100576 VDAYA KUMAR. P 117.206.86.233

VIRUDHUNAGAR 06/01/2011 11:03:00 100575 santhanakrishnan sp 218.248.84.83

SALEM 06/01/2011 11:00:00 100574 Kumar 61.14.6.131

DINDIGUL 06/01/2011 10:59:00 100573 Rajalingam 1232.238.227.240

TIRUNELVELL 06/01/2011 10:52:00 100572 .TUTHU BALASUBRAMANIAN. 117.206.83.145

DHARMAPURI 06/01/2011 10:50:00 100571 pontamilselvan. j 50.99.138.131

CHENMAT 06/01/2011 10:46:00 100570 Rajesh Kumar T 122.174.89.107

VELLORE 06/01/2011 10:38:00 100569 MAVAS A 117.241.210.137

ERODE 06/01/2011 10:37:00 100568 Sasikumar P 67.0.19.190

TIRUNELVELL 06/01/2011 10:34:00 100567 BALASUBRAMAMNIAN.P 117.206.87.152
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